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What You Will Need
•  ArcGIS Desktop (ArcView, ArcEditor, or ArcInfo 

license)
•  Sample dataset and DS Map Book utility from 

ArcUser Online
•  A zipping utility such as WinZip

For many years, emergency responders and 
public service field personnel have relied on 
paper maps to guide them to both emergency and 
nonemergency locations. These maps are often 
indexed and bound in a book. As computer-
aided dispatch and location services have been 
adopted for public safety applications, the focus 
is shifting from static paper maps to easily 
updated digital mapping.
	 This exercise introduces the DS Map 
Book, an ESRI ArcObjects developer sample 
available from the ArcGIS Developer Online 
Web site, and uses a different study area from 
recent articles, northern Whatcom County, 
Washington, and Fire District (FD) 21, a 
recently consolidated rural/urban district, that 
protects more than 145 square miles. It follows 
the United States-Canadian border from the 
Puget Sound shoreline at the border community 
of Blaine eastward to rural farmlands around 
the community of Lynden. In this area of rapid 
suburban and rural growth, three of the district’s 
stations are staffed by career staff and seven 
stations are staffed by volunteers. 
	 This exercise will build a map book layout, 
using one-mile square mapping tiles, include a 
reference grid on each page, and export pages 
as JPG files for display and printing. Using the 
new layer-based PDF export format, interactive 
pages will be created that can be loaded onto a 
rugged computer for field use. A similar map 
series can be built for half-mile square tiles for 
creating high-resolution map pages depicting 
more highly developed areas. 

Getting Started
This exercise requires downloading two items 
from the ESRI Web site: the sample dataset 
and the DS Map Book utility from the from 
ArcUser Online. The DS Map Book utility, 
along with other helpful scripts and utilities, 
is also available from the ESRI Support site 
(support.esri.com).

Deploying better map books for 
emergency responders
By Mike Price, Entrada/San Juan, Inc. 

Finding It
Fast

The 1-Mile Map Tiles layer supplies a consistent tiling system that the Map Book utility can 
use to generate map pages. Open the attribute table for the 1-Mile Map Tiles layer to highlight 
individual tiles. 

1.	 Visit www.esri.com/arcuser, look at the 
table of contents for this article, and look for 
the links to the sample dataset and DS Map 
Book utility. 

2. 	Click on the Download sample data link to 
download the 5 MB zipped sample dataset. 
Unzipping the archive will generate a 
directory called FD21_MapBook. Place 
this folder at or near the root directory. The 
directory structure includes a Utility folder 
that contains two completed Map Book map 
files that can be used for reference. Project 
data, obtained from Fire District 21 and 
Whatcom County GIS, has been simplified 
and standardized for training purposes.

3.	 The next step will get the developer’s 
sample. Create a Utilities folder in the 
project directory.

4.	 Return to ArcUser Online for this issue, 
locate this article, and click on the link to 
download the DS Map Book utility. Extract 
the archive file to the FD21_MapBook 

folder. This is an important step. The archive 
will create a folder called Visual_Basic. 

5.	 Click INSTALL.BAT to install the utility. 
Click Yes in the message box that asks if 
you want to edit the Register. A simple 
message stating that the registry has been 
edited should be displayed. 

Setting Up a New Map Book
1.	 Start a new ArcMap session. Choose Tools 

> Extensions and turn off all extensions.
2.	 Navigate to \FD21_MapBook\SHPFiles\

WASP83NF. Notice that shapefiles have 
associated Layer files. Save the document 
in the FD21_MapBook folder and name it 
MapBook_1.

3.	 Use the Layer files to load the data. Locate 
all 12 Layer files, then load them into the 
map document. 

4.	 Go to \FD21_MapBook\JPGFiles\
WASP83NF and load Background Image.
lyr. Rearrange the Table of Contents 
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Layer Name Description

Photo Control
The Photo Control layer is used to register the background image and 
reference data collected in the field. Control is optional and could be 
provided by the Public Works department or the County Surveyor.

Fire Hydrants
Fire hydrant locations are extracted from Public Works CAD maps or 
collected in the field. Their position relative to street edge is critical. Include 
information on tested static pressure and flow volume if possible. 

Fire Stations
This layer can include information about status, apparatus, staffing, and 
available resources.

Highways, Streets
Typically, this layer is symbolized by travel speed. Streets could also include 
geocoding address ranges if they will be displayed at a large scale.

Railroads
This layer is very important for rail transportation emergencies and 
identifying intermittent blocking of travel routes by slow freight trains.

Water Lines
Water lines are often considered nonessential for emergency response, but 
what if one breaks? Public Works staff can use the map book too.

PLSS
The Public Land Survey System (PLSS), where available, subdivides the 
jurisdiction into one-mile squares (sections) and quarter-mile aliquots (i.e., 
standard subdivision of an area of a section), ready for building pages.

1-Mile Map Tiles
These tiles were built directly from the jurisdiction’s PLSS. Be sure and 
include a unique label field to assign map book page numbers.

Quarter-Mile Map Tiles
Again, these are from the jurisdiction’s PLSS. There are typically four 
quarter sections for each section. A separate map book series may be built 
around these objects in dense areas.

Assessor Parcels
This huge dataset provides lot boundaries, occupancies, and more. A 
sophisticated parcel set might show building footprints on each lot.

Fire District 21
Boundaries for the home district and neighboring jurisdictions are essential 
for out-of-area responses and mutual-aid calls. Expand the map book to 
include the neighboring values and hazards. Cooperation is the key!

Municipal Boundaries
Municipal boundaries help define jurisdictional requirements and 
responsibilities.

Background Image

A detailed background image provides great visual confirmation but be 
sure that it is a current image. For many map book applications, especially 
for night operations, an image might detract from the map’s readability. 
One solution might be to print two map books.

Table 1: Order and description of data layers

It’s All in the Layout
The toughest issue handled in this exercise 
is creating individual pages. It requires 
considerable time and testing to build and 
deploy an effective map book. This section 
provides an overview of this challenge, which 
has three aspects—content, frame, and scale—
and they all come together in a layout.

Content
Content for this exercise has been largely 
handled by using the Layer files, which use 
premap and symbolized data. While completing 
this exercise, study the training data and think 
of other similar data that could be included.

Frame
Every great map book has a consistent tiling 
system. To see the tiling system for this map 
book, turn off the busy layers—Assessor 
Parcels; Water Lines; Railroads; Highways, 
Streets; Fire Hydrants; and Photo Control. Also 
turn off the Quarter-Mile Map Tiles layer. 
	 Open the attribute table for 1 Mile Map 
Tiles. It contains six contiguous polygons, 
arranged in an array coded by letters (rows) 
and numbers (columns). The Label field 
contains a unique identifier for each. Ideally, 
each polygon is one-mile square, but because 
the northern row follows the Canadian border, 
these polygons are half the size of the other 
tiles. These polygons represent the Public Land 
Survey System (PLSS) sections, and borders for 
these polygons often follow major streets and 
are consistent in size. Land survey information 
in PLSS is available for most of the western 
and central United States. If it is available for a 
desired area, it supplies a tiling grid that requires 
only a unique labeling matrix. If PLSS data is 
not available, a tiling grid must be created. That 
grid can use squares or rectangles.
	 Turn on the Quarter-Mile Map Tiles layer, 
open its table, and select a record. These are 
smaller tiles, labeled with the same Row and 
Column designators with an additional letter 
that identifies the tile. The strings (names) in the 
label field are unique so these smaller tiles can 
be mapped at a larger scale to provide greater 
detail in developed areas.

Continued on page 50

Time and location are critical and interrelated issues 
for emergency response personnel. In recent issues 
of ArcUser, a series of articles has demonstrated 
how to create service areas for existing and 
proposed fire stations in southern King County, 
Washington. This article uses data from an area 
farther north in the state of Washington—Whatcom 
County—and the DS Map Book utility to make 
digital and paper map books. The map book 
developer’s sample was featured in an earlier 
ArcUser article, “ArcGIS Software Simplifies Map 
Book Generation,” written by Nathan Shephard, 
Melanie Baker, and Larry Young of ESRI. 

SUMMARY

(TOC) with layers using the order shown 
in Table 1. This table also summarizes the 
data layers used in this exercise. Explore 
these data layers and study the labels and 
symbology. 

5.	 Rename Data Frame to FD21 Map Book. 

	 The toughest part of building a map book is 
creating meaningful display items that can be 
efficiently viewed and interpreted by responders 
in the field. Although it is not directly addressed 
in this exercise, it was part of the earlier ArcUser 
articles on Standards of Cover.
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Scale
Now to decide on the scale. These maps 
must contain enough data to be useful in 
the field and map features must be carefully 
labeled to show just enough information. Map 
extent must cover a reasonable area, slightly 
overlapping neighboring tiles; adjacent tiles 
are labeled and referenced.
	 This map book will print on letter-sized 
paper with a portrait orientation. Because 
most map tiles are square, not all the page will 
be used for mapping. The upper portion of the 
page will contain a title, reference map, and 
other information. Using a proportional scale 
of 1:8,000 will map a square mile on a page 
8.5 inches wide. The scale for the quarter-mile 
tiles will be 1:5,000.

Starting a Layout
1.	 Turn all layers back on and switch to 

Layout View. 
2.	 Open the 1 Mile Map Tile attribute table, 

select tile B19 in the table. From the 
Standard menu, choose Select > Zoom to 
Selected.

3.	 Stretch the Data Frame to the page margins 
and set the proportional scale to 1:8,000.

4.	 Save the map document.
	 This map is too busy for an emergency 
responder in a hurry. Experiment with turning 
data layers off and on individually  and in 
groups. Wouldn’t it be nice to have a digital 
map book that contained interactive layers? 
Actually, this is possible with the DS Map 
Book utility and a PDF export capability in 
ArcGIS Desktop 9.2. It would take several 
hours to build an effective layout for these 
one-mile tiles and several more hours to 
create a quarter-mile tile layout. To save time, 
the sample dataset includes prebuilt ArcMap 
documents for these scaled tiles. But before 
opening these documents, turn off all other 

Finding It Fast
Continued from page 49

Right-click on the Map Book header in the TOC to access the Map Sheet Wizard and create a map book series.

ArcGIS extensions before activating the Map 
Book utility as described in the next section. 

Loading and Testing
the DS Map Book Utility
Return to Data View and deselect all objects. 
Locate an empty spot in the toolbar area and 
right-click. Locate Map Series and select it. 
Verify that a three-button toolset and a fourth 
tab labeled Map Book (located at the lower 
right of the TOC) have been added to the 
interface. If the Map Book tab does not load, 
choose Tools > Options in the ArcMap menu, 
locate the TOC tab, check the Map Book tab, 
and click OK. (To remove the Map Book tab, 
just reverse this process.) Save the map again. 
	 To test the Map Book utility, build a 
preliminary map set using the 1 Mile Map Tiles. 
1.	 Open the TOC Map Book tab, right-click 

on the Map Book header, and select Add 
Map Series. Alternatively, use the Create 
Map Book tool on the new toolbar. Click on 
the tool and accept the default data frame.

2.	 Choose 1 Mile Map Tiles as the index layer. 
Select Label to specify page name. Click 
Next.

3.	 In the second window, accept all defaults 
and use all tiles. Click Next. 

4.	 In the third window, click the radio button 
next to Fixed—Always draw at this scale 
and specify a scale of 1:8,000 but leave all 
other options unchecked. 

5.	 Click Finish to build the pages. Save the 
map document. 

	 Six map book pages should be listed in the 
TOC. Locate B19 and right-click on its name 
(not its icon). Select View Page, and ArcMap 
will switch to Layout view, rescale the map, 
and display the map book page for this tile. 
View other pages and notice the pages will 
print exactly the information presented in the 
data layers in the TOC. Click on the Display 

tab to change the presentation. When finished, 
close ArcMap.

Loading and Exporting
Map Book Pages from Templates
In the interest of saving time, these next steps 
explore the functionality of the Map Book 
utility using two prebuilt ArcMap documents. 
1.	 Open Windows Explorer and navigate 

to \FD21_MapBook\Utility. Locate the 
MapBook1_Safe and MapBook2_Safe 
map documents. Copy them to the \FD21_
MapBook\ directory. 

2.	 Look at the Map Book Generation document 
for additional technical assistance on using 
the Map Book utility. 

3.	 Navigate back to \FD21_MapBook\ and 
rename each copied MXD file, changing 
Safe to Final. 

4.	 Open an ArcMap session and open 
MapBook1_Final. 

	 This document builds the 1 Mile Map Tiles. 
It should open in Layout view, and the MapBook 
TOC tab should be visible. Open this tab and 
notice six map book pages. View each one and 
study its page header, map label, and scale. The 
reference map for each page is stored in the 
Global Indicator data frame of the MapBook1_
Final document. These elements are built into 
the map template and conform closely to the 
district’s previous paper maps. Right-click on the 
Map Series header in the TOC and review the 
map production and management options. Pages 
can be printed individually or as a group.
	 To take full advantage of PDF layers, use 
Export Series to send each map to its own PDF 
file. 
1.	 Select Export Series and set the Save as 

Type to PDF. 
2.	 Browse to the \FD21_MapBook\MapBook\ 

folder and set the file name to FD21. The 
utility will name each page.
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3.	 Open the PDF Options and locate the 
General tab. Set the resolution to 300 dpi 
and slide the Output Image Quality selector 
to Best. 

4.	 Open the Format tab and check Embed 
All Document Fonts. This is especially 
important if the PDF map will be sent to  
someone who does not have current ArcGIS 
font sets.

5.	 Click OK to apply changes and close 
options. Return to the Export window and 
click OK to create the PDF Map Book 
pages. Watch the bottom of the Export 
window as all six maps build. Because 
these maps include a JPG image, assessor 
parcel outlines, and haloed labels, it will 
take several minutes to create them all.

	 In Windows Explorer, locate the \FD21_
MapBook\MapBook\ folder. It should contain 
six PDF files, ranging in size from 600 KB to 
1.3 MB. Open FD21_B19. This page should 
look just like the ArcMap layout. Now for the 
best part—locate and select the PDF Layers 
tab in the upper left to see the 18 separate 
layers associated with the primary map and 
the index. Experiment turning layers off and 
on by clicking on the eye-shaped visibility icon 

Open the MapBook1_Safe.mxd and rename it MapBook1_Final.mxd. It contains six map book 
pages that are very similar to the district’s previous maps. Notice the reference map in the 
header highlights the area shown on each map page. 

Continued on page 52
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MapBook2_Final.mxd generates 18 map pages for quarter-mile map tiles covering the same 
area that provides greater detail.

and try printing several maps with different 
layers turned off. The ability to control layer 
visibility makes this complex map more 
comprehensible.

Build Quarter-Mile Map Tiles
Only one map series can be created per ArcMap 
document. Consequently, the quarter-mile tiles 
reside in a separate, but similar, document 
called MapBook2_Final. 
1.	 Save any changes to MapBook_1 and close 

it. Open MapBook2_Final. Verify that there 
are now 18 pages, mapped at a scale of 
1:5,000. 

2.	 Export all 18 pages to PDF, using the process 
employed for the 1 Mile Map Book series. 
The DS Map Book utility will manage the 
file names. Be patient as this process will 
take several minutes. 

3.	 When it is finished, open the PDF files. A 
larger scale is helpful in congested areas but 
results in approximately four times as many 
maps. Imagine how these maps will display 
on a rugged field computer or a computer on 
an apparatus on scene. 

Summary 
The data for these map book pages is continually 
updated as communities in the area grow and 
data quality is improved. In the past, updating 
a map book was a difficult and time-consuming 
process. FD 21 personnel continually field 
validate speed limits, hydrant locations, and 
new construction. Now incorporating field-
validated data to update existing data layers, 
add new layers, and rebuild the PDF maps is 
a very quick and painless task. New PDF maps 
can be quickly transferred to field personnel to 
replace versions. It is so easy to update digital 
pages, it is hard to go back to paper alone!
	 This exercise will be used in continuing 
national training sponsored by ESRI and the 
National Alliance for Public Safety GIS. It 
will also be modified to use Corpus Christi and 
Nueces County, Texas, data as part of the GIT-
TECH Fire Responder training, sponsored by 
Del Mar College and funded by the National 
Science Foundation.
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